[image: image1.png]e o a
VAR NE (¢
NO {0
L1t}




[image: image8.png]



Peter Faulks     Using Microsoft Word
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Items highlighted in yellow are tasks for you to complete
Items in Blue are help tips

MWP 109 Drawing and WordArt
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Drawing can help create interest in a presentation. Drawing tools can also be used to create diagrams and schemes. Drawing tools include shapes, lines, and text boxes.
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WordArt is a great way to format text to give it extra special impact.
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In this section you will

· Create Drawing Objects

· Create WordArt Objects

· Format and work with Drawing and WordArt Objects

The Drawing Toolbar

All the examples on the introduction page were produced using the Drawing Toolbar.

The Drawing toolbar is usually located at the base of the screen.

· If you cannot see the Drawing toolbar click on View ( Toolbars ( Drawing to display it

To Draw an Object

We will start with some basic shapes then move onto some of the AutoShapes.

· Open or display the file Drawing
· Add a New slide with a Blank layout

· Click on the Rectangle button 

  in the Drawing Toolbar

· Move the mouse to the slide then click, hold and drag the mouse over the slide.

As you drag the mouse, the outline of the shape will appear.

· Release the mouse when you are satisfied with the size

· Repeat the procedure for the Oval 

 and Line 

 buttons. You could try to draw the example below 
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Using the freeform and edit points, draw any shape using 

multiple mouse clicks, the click on shape and select edit 

poins
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and change the shape
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Trace around the leaf

Using Text Boxes

The Text Box tool is useful for inserting extra text on a slide.
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· Click on the Text Box button  - then click on the screen where the text is to appear

When you release the mouse the insertion point will be ready to type some text.

· Type the text below or something of your own in the Text box.

As you type the text box will increase in size to accommodate the text. When you have finished typing you can resize the box to the appropriate dimensions.
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Display the slide with the Title Office Attire
· Insert a text box and enter the text as shown on the left of the slide - use the Right Align button on the formatting toolbar to line the text up on the right

· Insert a text box and add the text as shown on the right of the slide

To Draw an AutoShape

· Add a New slide with Blank layout

· Click on the AutoShapes button 

 on the Drawing toolbar to display the AutoShapes List

· Point to Block Arrows
· Click on the Right Arrow Tool shape 

 on the AutoShapes Toolbar
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If you look closely at the arrow while it is selected you will notice a small diamond. This appears for some of the AutoShapes. It indicates that the shape is adjustable.
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Practice with some other AutoShapes
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Working with Drawing Objects

To work with objects we have to select them first.
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To Select an object

· Click on a visible part of the object (but not over the text if there is text) - the resize handles will appear
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To Deselect an Object

· Click on a blank area of the slide

· Practise selecting and deselecting each object on the slide

Selecting Multiple Objects

We can select objects together. This is helpful if we want to maintain positioning relative to each other but want to alter placement of the set. We use the [(Shift] key on the keyboard to select multiple objects.

· Click on the first drawing object

· Press the  [(Shift] key  down and hold

· Click on another object

· Continue to click on all the shapes or objects you have drawn while still holding the [(Shift]  key

· Release the [(Shift] key

Your selection should look like this.
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· To deselect any object just click on it again while holding the  [(Shift] key 

· To deselect all the shapes at once just click on a blank area of the document

· Deselect all the objects to return to normal

Colours and Styles of Lines and Drawing Objects
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The Drawing toolbar also enables us to apply various colours and styles to our Drawing objects. 
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Fill Colour



All drawing objects can be coloured in.

· Click on the drawing object

· Click on the Fill Colour drop list button and choose a colour
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Line Colour



All lines and outlines of drawing objects can be coloured.

· Click on the line or drawing object

· Click on the Line Colour button and choose a colour

Shadow






We can give drawing objects a shadow.

· Click on the drawing object

· Click on the Shadow button to give the object a shadow

Line Style



Lines can be various thicknesses and styles.

· Click on the line or drawing object

· Click on the Line Style button and choose a style

Arrow heads



There are various sizes of arrowheads we can apply to lines.

· Click on the line

· Click on the Arrow Style button and choose an arrow head style

Dashed Lines





There are various types of dashed lines we can apply to the lines we have drawn.

· Click on the line

· Click on the Dash Styles button and choose a line type

Arcs and Rotations

We can achieve some fantastic effects using Arcs and Rotations. An Arc is a line with one curve that can be from anywhere as round as a circle right out to virtually a straight line.

Drawing and Editing an Arc Object
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PowerPoint enables us to draw and edit arcs with the Arc Tool located in the AutoShapes.
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· Add a New slide with a Blank layout 

· Click on the Arc Tool 

· Move the mouse over the slide - notice it has become a cross hairs (
· Drag from the top left down to the lower right

You should have an arc that looks like the top left arc below.
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· Try the other directions as shown - each time you draw a new arc you must click the arc tool again

Editing the Roundness of an Arc

We change the roundness of an arc line by dragging the line to the required shape.

· Position your pointer on the arc line and click to select it

Resize handles will appear around the line

· Click on the left resize handle and drag further to the left

As you drag a broken line will indicate where the line will be and the shape it will take if you release the mouse at that particular point.

· See if you can edit the arcs to appear as below.
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Edit the Angle of an Arc

So far the Arcs we have created are only the curve of an ellipse for an angle of 90 degrees. We can increase or decrease the angle of the curve, ie an arc that was virtually a circle would have an angle of nearly 360 degrees.

To change the angle

· Resize the arc to small as shown below

· Click on the yellow handle at the end of an arc line - a handle will appear at each end of the arc line

· [image: image51.png]


Drag one of the handles around to increase the angle of the arc

· Click anywhere off the line to deselect it

· Try to form the shape shown to the left with the four arcs you produced before - you may need to change the roundness as well to get the four small circles

Practice Exercises
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5.1 Display the slide Distribution Network and draw the arc lines them format them to be dotted

5.2 Add a new blank slide and create the following drawing
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Hint : The text is in a text box over an oval shape. The text box has no border.

Drawing a Freeform Object
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A Freeform object is a combination of our efforts at freeform lines and if required straight lines.
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Straight Line

· Add a New slide with a Blank layout

· Click on AutoShapes (Lines then the Freeform Tool 


· Click on the starting point for your shape - release mouse button

· Click on the next point, release

· Continue until you form a square or rectangle


Freeform

· Click on the Freeform tool 


· Click on the start point, drag the mouse to make design,  the mouse will have changed to a pencil

· To turn off the Freeform tool to finish a line just double click

· Try drawing a daisy - or if you’re adventurous try the teddy above

Once created, a freeform line is like any other drawing shape that can be formatted, moved etc.

Rotating and Flipping Objects

Drawing objects can be flipped and rotated to the required aspect.

· Click on the slide Flip
This slide has four bolts of lightning however three of them face the wrong way. They must be rotated or flipped so they face the required direction as shown below.

· Select the object in the top right corner

· Click on Draw ( Rotate or Flip in the Menu Bar 


· Click on the Rotate Right button 

· Try rotating the other bolts with the rotate and flip tool buttons so the slide appears as below

Free Rotation

The Free Rotate Tool allows us to rotate the drawing object to any angle.

· Display the slide Free Rotate
· Select the Shape

· Click on Draw(Rotate or Flip (Free Rotate on the Draw menu

Rotate handles will appear around the shape.

· Click on one of the corner handles as shown below and drag, an outline will indicate the position

· Release when happy with position



· Display the slide Arrow Colour Logo No 1 and rotate to appear as to the right


Copy a Drawing Object

Any object that is selected can be copied then pasted elsewhere in the presentation. We will try it with the Arrow, making a copy for the same slide

· Display the slide Copy and Click on the Arrow shape to select it

· Click on Copy button 

 in the toolbar OR Edit ( Copy in the Menu Bar 

· Click on Paste 

 in the toolbar OR Edit ( Paste in the Menu Bar

A copy of the arrow will be pasted to overlap the original arrow. It will be selected. Now we can just move it to the correct position on the slide




Move a Drawing Object on the same slide

Drawing objects can be moved the same way that ClipArt can.

· Position the mouse pointer over the top of the drawing object

· Click, hold and drag the object to the required position

Move a Drawing Object to another slide

· Select the object to be moved

· Click on Cut 

 in the toolbar OR Edit ( Cut in the Menu Bar 

· Display the slide where the object is to be placed

· Click on Paste 

 in the toolbar OR Edit ( Paste in the Menu Bar

· Practice moving and copying the drawing objects you have created.

Grouping and Ungrouping Drawing Objects

Objects can be grouped together so that we can move or copy them easily. 

· Add a new blank slide and draw the following set of shapes


Suppose we wanted to move the shapes one centimetre to the right. What a nuisance. However if they are grouped together their positions relative to one another will be maintained.

· Click on the first shape to select it

· Hold down the [(Shift] key and click on the other shapes


· Click on the Draw Menu button 

 then the Group button 

 


Notice the resize handles are now just around the whole group.

· Move the group – all the shapes should move together

· Click on the Draw button then the Ungroup button 

 to return the objects to be individual objects

· Click on a blank area of the slide to unselect all the objects

Stacking Objects

You can change the order of objects in a stack.

· Display the slide Stacking
· Click on the circle to select it 

· Click on the Draw button in the Drawing toolbar



· Point to Order to display the Stacking buttons


· Click on the Send to Back button 


The circle will be on the bottom of the stack.

· Click on Draw(Order( Bring to Front button 


The Shape will back on top. Several shapes can be ordered by using the Bring Forward and Send Backward button.


Practice Exercise

· Create the following set of objects as an outline for a logo

· Use the stacking buttons so they are in the correct order

· Group the objects together so they are set in place

Practice Exercises

5.3 Arrow Staff Induction

· Open the file Arrow Staff Induction and add the slide to the right

· Add another new slide with Title layout

· Enter the title Arrow Company Logo
· Draw the following 

· Save and Close the presentation when finished

· Start a New presentation with a Blank slide layout

· Use the drawing objects and stacking features to create this slide that could be used as a background

· Save the presentation as Background
· Close the file when finished

Inserting WordArt

WordArt is a small program that enables us to do wonderful things with text. The text used in WordArt is an object and thus can be moved around, resized and edited at any time.


Here are some examples of WordArt.


WordArt is inserted into a slide via a button on the Drawing toolbar.

· Add a New slide with a Blank layout

· Click on the WordArt button on the Drawing toolbar at the base of the screen



The WordArt Gallery will appear.

· Click on a style box to choose a WordArt style then click OK

The Edit WordArt Text box appears. This is where you type the text you want to be in the WordArt.


· Type the word PowerPoint then click on OK

The text now appears on the slide as shown below. The WordArt toolbar may also appear.



· Click on View ( Toolbars ( WordArt to display the WordArt toolbar if it is NOT on the screen

Formatting WordArt

We can format the text in the WordArt the normal way ie. changing the font style and size. However the great feature with WordArt is the way we can shape the text with the tools on the WordArt toolbar.

Eg. 



 EMBED MSWordArt.2 \s 
 





The WordArt Toolbar

The WordArt toolbar usually appears when the WordArt object is selected.

· Click on View ( Toolbars ( WordArt to turn on the WordArt toolbar if it is NOT on the screen






· Experiment with the options on the WordArt Toolbar

· When finished click outside the WordArt object to deactivate it - now you can work with PowerPoint as normal

To Resize WordArt

WordArt, like any other Object such as ClipArt or a Drawing object, can be moved and resized.

· Click on the WordArt object

The WordArt object appears with resize handles. 

· Move the mouse over the resize handle until a double - headed arrow appears

· Click on the resize handle, hold and drag to the required size


 EMBED PBrush  



To Move WordArt

· Move the mouse over the top of the object, click, hold and drag to desired position

To Edit WordArt Text

The WordArt object must be activated to edit the text or any of the formatting in the object.

· Double Click on the WordArt object to activate it - the WordArt Toolbar will appear again

· Make selections as normal then click outside the WordArt area to deactivate it.

· For practice create the rest of the WordArt shapes to create the following sentence (you will create four separate WordArt objects)

Eg. 
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Text Boxes (Locking)

Open the Microsoft Word document that contains the text boxes that you want to lock. Right-click on the text box you want to lock and then click on the “Format TextBox” option.

Click on the “Layout” tab and then click on the “Advanced” button. Select the “Alignment” option below the “Vertical” heading and then select the “Bottom” option from the drop-down menu.
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Select the “Margin” option from the drop-down menu next to the “relative to” field. Click on the box next to the “Move object with text” field so that it’s deselected.
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Click on the box next to the “Lock anchor” field so that it’s selected. Click on the “OK” button.

Move your cursor about the text box. Click on the “Insert” option from the top toolbar menu and then click on the “Break” option if you’re using Word 

2003. Click on the “Page Layout” tab and click on the “Breaks” icon for Word 2007.

Select the “Continuous Break” option. Click on the “Tools” option and then click on the “Protect Document” option for Word 2003. Click on the “Review” tab and click on the “Protect Document” icon for Word 2007.

Click on the “Select sections” option and then select the section of your document where your text box is located. Click on the “OK” option and then click on the “Yes, Start Enforcing Protection” button.

Wrapping through an object

1. Select the picture. Use Transparent Colour to remove background


Edit Wrap Points without transparent colour removed

[image: image6.png]



Edit Wrap Points with transparent colour removed
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2. Click the Text Wrapping tool in the Picture toolbar and select Edit Wrap Points from the drop-down list.

3. Use the dashed red line that appears around your picture to change the border by clicking and dragging one of the handles with the mouse pointer to where you want the edge to be. 

4. Continue adjusting the points around the picture until the text is correctly positioned around the picture. The text will adjust accordingly.
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Drop list button
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Drag the diamond to the left to adjust the arrow head





The mouse changes to just an arrow head which indicates you can adjust the AutoShape





Position the mouse  to the left of the slide, click, hold and drag over and down to the lower right to draw the arrow, release the mouse
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Print Text





Preview Text





Proof Text





Enter Text
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Freeform tool





Free Rotate handle











Dream Card
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The WordArt toolbar





Rotates characters on side





Colour and pattern on text





Rotate


words





Insert another WordArt object





Expand to fit frame
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Change shape





Capitals same size as lowercase





Change text, font and size, use bold or italic





Centre text in frame





Resize handles
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